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MLA Citation 
 
In this class, you must use basic MLA citations when you borrow material from an 
outside source. You will be required to use the MLA Handbook, a required text for this 
class. We will cover very basic features of MLA in the class, but you will be required to 
do most of the work yourself. 
 
Incorrect citation will not be accepted. In some classes, incorrect MLA citation is 
considered equal to plagiarism, so this is very important! 
 
You must give a citation every time specific information is used. It does not matter if you 
quote directly or paraphrase—you must always cite borrowed material! Information 
considered to be well-known does not need to be cited; for example, that America has 
50 states, or that Donald Trump was elected president, are so well-known that you don't 
need a citation. But if you have to look something up, then you must cite it. 
 
This handout is intended to help you with basic citations, but do not use this handout 
only! You must use the MLA Handbook in many cases. That is why it is called a 
“Handbook”; it is used all the time, so keep it close at hand. 
 
Basics of Citation 
 
MLA citation consists of two parts: the in-text citation, and the works-cited listing. These 
two items work together. Both are required; if one is missing, then your citation is 
incomplete and will not be accepted. 
 

• The in-text citation shows the location of the borrowed information 
• The works-cited listing gives detailed information on the source 

 
Details about the in-text citation: 
 

• It appears in parentheses, and so is often called a “parenthetical citation”; 
• It usually appears at the end of a sentence before the final punctuation; 
• It requires an identifying name, usually the last name of the author. This is used to 

find the item in the works cited list; 
• If an author’s last name is not available, then the initial phrase of the title is used, 

without the initial article (e.g., “The Black Hills of South Dakota” would be 
written as “Black Hills”); 

• If a page number is available, it comes after the identifying name. 
 
Details about the works-cited listing: 
 

• The list always begins at the top of a new page; use a “page break” to do this; 
• The title “Works Cited” is centered at the top of the page; 
• Each citation listing is one paragraph; 
• The list is in alphabetical order; if there is no author and the source's title comes 

first, ignore (but do not omit) quotation marks and initial articles (A, An, or The). 
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• Citation listings are always given a hanging indent (the first line of each new 
paragraph is normal, and the other lines are indented by ½-inch). The reason is so 
the identifying name is easy to see; 

• Each citation listing must begin with the same identifying name which is in the 
in-text citation. 

 
Keep in mind that the 8th Edition of the MLA manual has significant changes from 
previous editions. The handbook no longer gives specific citation rules for each type of 
citation; instead, general rules for citations are given, making the citations somewhat less 
rigid and well-defined. Also, the format of citations has changed quite a bit; if you 
learned MLA under the 7th edition, you will want to review the new styles. 
 
To create a citation using the manual alone, try to find an example close to your source 
type; look up missing pieces or special-case information in the index at the back of the 
manual. When in doubt, get help from a teacher or tutor. 
 
Basic Citation Form 
 
Most citations follow a similar pattern, in which information is presented in a specific 
order. The order of citation of information, in short, is generally: 
 

• Author’s name. 
• Title of source. 
• Title of container, 
• Other contributors, 
• Version, 
• Number, 
• Publisher, 
• Publication date, 
• Location. 

 
This order is true for all citation types, but various types require more information than 
is shown here. Don’t leave out anything! For example, with articles, you must list two 
titles (the article and the magazine); with web pages, URLs may be required, etc. 
 
The general rule in citations is to ensure that you have given enough information and 
detail so your teacher can, without much trouble, track down the exact location of the 
source you used. 
 
To summarize best, we'll first go over the individual parts, and then look at examples of 
citations for specific source types. 
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1. Author's Name 
 
In the case of one author, the name is listed with family name first followed by a 
comma, then the first name, and then the middle name or initial; follow the form given 
in the publication unless there is a specific reason to do otherwise. For example: 
 

Smith, John C. 
 

If there are two authors, then give the first name as shown above, and then give the 
second name in normal order after a comma and the word "and": 
 

Smith, John C., and Mary S. Jones. 
 

The names should be listed in the same order as given in the publication. 
 

If there are three or more names, then only give the first author's name, followed by "et 
al" ("and others"): 
 

Smith, John C., et al. 
 

A period ends the listing of name(s). 
 
2. Title of Source 
 
This is the title of the work you are citing. If it is a complete work (a book or 
movie, for example), then give the name in italics. If it is part of a larger work (an 
article in a magazine or web site, a song in an album, a TV episode from a TV 
series, etc.), then the title is in quotation marks: 
 

Pride and Prejudice. 
"Why Rural America Voted for Trump." 

 

Capitalization is decided by rules in MLA section 1.2.1 (page 67). The title is 
followed by a period. 
 
3. Title of Container 
 
If the title of the source is part of a larger work, then the larger work is listed after 
the smaller source, in italics, using the same rules of capitalization as the source: 
 

The New York Times, 
CNN, 
The Big Bang Theory, 

 

Note that these titles are followed by commas, not periods. 
 

Containers can come in other containers; if an excerpt from a book is listed in 
another book, for example, then the original book is the first container, and the 
collection of excerpts is the larger, second container. A TV series is the first 
container, but may be found in an online streaming service such as Netflix, which 
would be the second container. More commonly for LUJ students, you might find 
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a newspaper or journal article in an online scholarly database such as JSTOR or 
ProQuest; in such a case, the newspaper or journal would be the first container, 
and then the online database would be the second and larger container. 
 

See pages 32~36 in the MLA Manual for examples of detailed container 
information in the case of journals, TV shows, and collections of works. 
 
4. Other Contributors 
 
If the source has people aside from the main authors who significantly 
contributed to making the overall work, they can be added at this point. This 
would include editors and translators especially, but also directors, performers, or 
illustrators, as well as others. For example: 
 

edited by Joseph Jones, 
translated by Juanita Garcia, 
directed by George Lucas, 
performance by Harrison Ford, 

 

This information ends with a comma. 
 
5. Version 
 
The version can include editions of a book (numbered editions, or editions with 
names such as final, international, or abridged), the director's cut of a film, or any 
other variation from previous versions of source material. 
 

8th ed.,  
widescreen 25th anniversary edition, 
King James version, 

 

This information ends with a comma. 
 
6. Number 
 
If there is a volume, journal, issue, or other number which describes the number 
of the work in a larger set of works, the number should be noted: 
 

vol. 42, 
no. 73, 
season 6, episode 12, 

 

This information ends with a comma. 
 



  Page 5 

7. Publisher 
 
The publisher is the organization primarily or immediately responsible for 
publishing the work. This includes publishers of books, journals, and web sites, 
but also production companies, film studios, etc. 
 

Oxford UP, 
Warner Bros., 
Vintage eBooks, 

 

This information ends with a comma. 
 
8. Publication Date 
 
You must include the date of publication which is most closely connected to the 
source you are citing. Do not cite the original publication date if your source is an 
edition with changes, even changes in pagination. However, do not cite the date 
of printing if it is different from the relevant copyright / publication date. Books 
and films commonly use only years, but if there is a journal or newspaper with 
daily, weekly, monthly, or other periodical publication dates, then a more 
specific date must be noted. If you use months, then give a three-letter 
abbreviation, except for May, June, or July. If there is a date, then list the date, 
then the month, then the year. For example: 
 

2011, 
Dec. 2011, 
11 Mar. 2011, 

 

This ends with a comma, or with a period if it is the final piece of information in 
the citation. 
 
9. Location 
 
In this case, location does not refer to the city or address of a publisher, but 
instead it notes the location of the cited material within a medium—for example, 
page numbers in a book, a time range within a recording, or a URL on the World 
Wide Web. It can refer to a physical location if it is a stage performance, lecture, 
or other live event, and the location is relevant. For example: 
 

pp. 103-117. 
disc 2. 
http://nyti.ms/2jaWm4m. 

 

This information ends with a period. 
 

Note: in the case of URLs, you can add shortened versions so long as they are 
permanent (follow the share  icon). Your teacher may instruct you to include 
longer URLs or not to include any URL at all; ask to be sure. 
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Common Citation Types 
 
1.  Periodical (Journals, Magazines, Newspapers) 
 
A basic citation looks like this: 
 

Author’s name. “Title of the Article.” Periodical Name, publication information.  
 
 
For scholarly journals, publication information includes (1) the volume number, (2) the 
issue number, (3) the year of publication, and (4) the page numbers of the entire article. 
 

Williams, Linda. “Of Kisses and Ellipses: The Long Adolescence of American 
Movies.” Critical Inquiry, vol. 32, no. 2, 2006, pp. 288-340. 

 
 
For newspapers, publication information includes (1) the city name, if the newspaper is 
local and the city is not in the title; (2) the date of publication; (3) the edition (if there is 
one); and (4) the section/page numbers. 
 

Alaton, Salem. “So, Did They Live Happily Ever After?” Globe and Mail 
[Toronto], 27 Dec. 1997, D1+. 

 
 
For popular magazines, you do not include volume and issue numbers even if they are 
available. Publication information includes (1) The date of publication, and (2) the page 
range.  
 

Weintraub, Dermot, and Laura Cohen. “A Thousand-Year Plan for Nuclear 
Waste.” Business Week, 6 May 2002, pp. 94-96. 

 
 
There are variations, such as multiple or corporate authors, or supplementary 
information. However, the above information is usual. 
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2.  Non-Periodical Print (esp. Book) 
 
A basic citation looks like this: 
 

Author’s name. Title of Publication. Publisher, Year of Publication.  
 
In an actual citation, this will look like: 
 

Kaku, Michio. Hyperspace. Doubleday, 1995.  
 
For books, there are a number of additional points that might change the citation. These 
must be added one by one. For example, the book you are citing may be a translation, in 
which case the translator’s name may need to be added, or it may be a numbered 
edition, in which case you would add the edition information. 
 
Publishers' names can be confusing, because there are often "imprints," or divisions/parts 
of publishing companies. Look for the primary publisher, and do not add the name of 
the imprint to the citation. Imprints are often noted as being "a division of", or a 
registered trademark of a publisher. You will commonly see, "A(n) [imprint name] Book, 
Published by [actual publisher]." 
 
Publication dates can also be confusing, as there will usually be a date for the original 
publication, dates for subsequent copyright renewals, dates for different editions, and 
even dates for incorporated work (illustrations, forwards, excerpts, etc.). Find the 
publication year which is most closely associated with the specific edition you are 
citing. 
 
A difficult part of making citations is finding and adding all necessary details like this. 
Here is a list of some of the details you may have to find and add: 
 

Anthology or compilation  
Two or more authors 
A corporate author (e.g., the MLA manual) 
A reference book (e.g., dictionary or encyclopedia)  
A translation  
A graphic novel  
A republished book (e.g., paperback, reprint, or other edition) 
A book not published in English 

 
Additionally, you must be careful to follow these two sets of rules: 
 

1. Title Capitalization (1.2.1) 
2. Publisher Name Abbreviations (1.6.3) 
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3.  Web Source (original; not in print or elsewhere) 
 
A basic citation looks like this (note formatting such as quotes and italics; font color is 
used to show parts): 
 

Author’s name. “Title of Article.” Title of Web Site, Publisher (if different from title 
of web site), Date of Publication, URL, Date of access.  

 
The URL should not include http:// or https:// or any other similar precursor. 
 
The date of access is optional, and should be included if (1) the page changes or is 
edited often, or (2) there is no date of publication given on the site. 
  
In an actual citation, this might look like: 
 

Connelly, Marjorie. "A View That Changes with Age." The New York Times, 12 
Apr. 2005, nyti.ms/2gfs4Pw. 

 
The URL is considered standard but optional; a teacher may ask for it not to be used. 
Any address marked as a "Permalink" is preferred, as that suggests the page URL will not 
change over time. Full URLs are acceptable although are often extremely long.  
 

One way to shorten long URLs is to exclude the "Get" code that is sometimes included 
in them. At some point in the URL, you may see a question mark (?) followed by extra 
text, often a confusing jumble of short abbreviations and code; often this is code added 
to the URL to carry data (such as settings, search criteria, and preferences) from one page 
to another. If you see a question mark in the URL, delete the question mark and 
everything following it. Then try using the shortened URL and see if the page loads as 
expected. If it does, then use the shortened version. For example, both the URLs below 
work fine: 
 

abcnews.go.com/Entertainment/wireStory/columnist-nat-hentoff-dies-91-
44630817?cid=clicksource_4380645_5_heads_posts_headlines_hed 
 

abcnews.go.com/Entertainment/wireStory/columnist-nat-hentoff-dies-91-44630817 
 

A teacher may allow the use of shortened links, as available through services like bit.ly. 
 

Make sure that you carefully judge the reliability of the site; try to use material primarily 
from professional, scholarly, or mainstream news sites, and do not even trust them 
100%. Always try to use the original source of the data; if your web site got the data 
from somewhere else, find the source and use that. 
 

It is not necessary to cite the first web site you find information from. For example, you 
can find information on a Wikipedia page, then search for the same information on a 
more professional site, and then cite the professional site and not Wikipedia.
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4.  Periodical in an Online Database  
 
This is important for LUJ students, as the online databases (ProQuest, EBSCO) are often 
used for periodical articles. 
 
This is a section which asks you to take a regular Print citation model and add citation 
information showing where you found it. 
 
In this case, take a Periodical citation, and add: 
 

1. Title of database (italicized) 
2. URL 
3. Date of access (optional) 

 
A basic citation looks like this (note formatting such as quotes and italics; font color is 
used to show parts): 
 

Author’s name. “Title of the Article.” Periodical Name, publication information, 
Title of Database, Location. 

 
In an actual citation, this will look like: 
 

Goldman, Anne. “Questions of Transport: Reading Primo Levy Reading Dante.” 
The Georgia Review, vol. 64, no. 1, 2010, pp. 69-88, JSTOR, 
www.jstor.org/stable/41403188. 
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What Citations Should Look Like 
 
Even with the previous explanation, many students still have trouble producing correct 
citations. It is important to note: 
 

1. You must always have an in-text (parenthetical) citation marking the borrowed 
information (the same source might be cited more than one time in different 
places in the essay); 

2. Every citation in the text must match with a works-cited listing; 
3. Every works-cited listing must have at least one in-text citation to match it; 
4. Every matched citation/listing must begin with the same name. 

 
Take the sample given below as an example of how an in-text citation and a works-cited 
listing might appear in an academic essay. 
 
 

 

 
This is an example of a web page citation; if it were a book or periodical, a page number 
would be required after the author’s name inside the in-text citation. 
 

If you have any questions or thoughts about how to cite information in your essay, then 
do not hesitate to ask your teacher!! It is a very important issue, and you must not make 
mistakes!  
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The MLA Format 
To make an academic essay in the Humanities, one usually is required to follow the MLA 
format. This consists of a variety of details. They include: 

❖ Margins: 1” at top, bottom, left and right; ½” for header 

❖ Line Spacing: double-spaced 

❖ Alignment: Left (except for titles, which are centered); do not use “Justify” 

❖ Indent: ½” first-line indent for essay paragraphs; ½” hanging indent for citations in works 
cited list; 1” left indent for long quotes; and no indents for titles and header information 

 

Each essay must have the following: 

❖ Header: At right (type two tabs), your family name (capitalized), followed by a space, 
then the page number (insert the auto-text page number from the toolbar). 

❖ First-page Information: At the top of the first page, left-aligned, no indent, type: Your full 
name; the professor’s name; the class title; and the date. Your instructor may ask that you 
change this information or its ordering. 

❖ Title: This must be centered, using title case. 

❖ Works Cited List: The Works Cited list must begin at the top of a new page. It is best to 
use the “Insert” menu, “Break” command, “Page Break” selection. The list must have a 
title (center alignment), followed by the list of sources (left alignment, ½” hanging 
indent), in alphabetical order. 

 

Japanese-English MS Word Format Problems  

There are differences between the English and Japanese versions of MS Word. In order to 
make an academic paper in the correct format using the Japanese version of MS Word, you 
must make the following changes: 

❖ Double-spacing: Japanese double-spacing is wider than in the U.S. To make the correct 
spacing in the Japanese version, open “Page Setup” by double-clicking on the ruler over 
the margin; click on the “Document Grid” tab; then, under “Grid,” select “No Grid. (Each 
language has different titles!) Then click “Default” to make the change permanent. Your 
spacing should be acceptable for an MLA paper now. 

❖ Alignment: Asian-region word processors automatically use the “Justify” alignment. 
Change this to “Left” when typing an MLA paper. Go to the “Format” menu, choose 
“Paragraph,” and set the Alignment to “Left.” Use “Default” to make it permanent. 

❖ Widows and Orphans: It is considered bad style for only one line of a larger paragraph 
to remain on one page, or to extend to another. This is called “Widows and Orphans.” 
This is turned off in Japanese; you must turn it on. Go to the “Format” menu, choose 
“Paragraphs,” and select the “Line and Page Breaks” tab. Then click the box next to 
“Widow/Orphan control.” 

❖ Paper Size: In the U.S., Letter size paper is used; in Japan and elsewhere, A4 size. You 
can change the paper size in the “Page Setup” dialog box. 
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First page: 
 
 

 
 
 
Successive pages of essay: 
 

 
 
 
Works Cited List page: 
 

 
 

Left aligned, 
no indent 

Centered, Title capitalization 
(MLA p. 86) 

Left aligned, first line 
indent of 0.5” 

Top & bottom 
margins 1” 

Header 
margin ½” 

Left & right 
margins 1” 

Left aligned, 
hanging indent 
of 0.5” 



 Page 13 

 

The mind is a strange and wonderful thing. We think of it as being rational and literal, a 

machine that shows us exactly what our senses take in. The reality, however, is that our minds 

fool us on a regular basis. That is not a design flaw, though: the brain plays tricks on us in 

order to function properly. The brain will create information which does not exist. For 

example, when I was a child, I burned a spot on the retina of my right eye, creating a blind spot 

there. However, I rarely see it, because my brain pays attention to the information from my left 

eye and “fills in” the blind spot in my right eye. Similarly, you might think that you saw a 

person’s face clearly as you glanced out the window, but in reality you only saw a blur. Your 

brain created the face from the insufficient information your eyes sent. This is similar to how 

we “see” faces in clouds (“Tricks”). As useful as these tricks can be, they sometimes do us 

wrong. Even a very rational and science-minded person can hear his parents’ voices clearly, 

years after their deaths (Sagan 104). Much worse, the brain can create pain that is not there; 

people who have lost their arms in accidents report terrible pain in hands which no longer exist, 

pain they cannot relieve. The pain is so great that some people even contemplate suicide 

because of it (Ramachandran and Blakeslee 22). Instead of relaying the real world to us in an 

accurate way, our brains in fact distort the information we sense greatly.  
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